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Project Background and Scope

As a part of addressing sustainability of projects
in rural Alaska, capital funding and constructing
agencies require communities to complete a
business plan for projects that are being built.
Whether it is a water system, wastewater system,
bulk fuel farm or power plant, the need for a
solid business plan to achieve sustainability is
apparent.  

This need prompted each individual agency to
create a business plan model that suited their
particular agencies needs.  The different formats
of these plans often required the same
information be presented in a different format,
order or manner. If a community received project
funding from two different agencies, they would
be required to do two different business plans in
differing formats. In addition to possibly having
to complete two separate plans, there were no
provisions in the plan to address how each
project may affect the other.  This has lead to a
confusing system that ultimately does not benefit
the community in developing a plan that will lay
the framework for sustainable infrastructure.

At the urging of rural policy groups, the
Department of Community and Economic
Development’s (DCED) Rural Utility Business
Advisor (RUBA) program, sought and received
funding from the Environmental Protection
Agency (EPA) to create a template model that
would streamline community business plans for
each of the agencies involved in rural Alaska
capital projects.  

The goal of this template and guidebook is to
allow the community to develop its own business
plan in an easy to follow and logical format that
will also satisfy each funding agency’s
requirements for a project business plan. The
plan is not meant to be a one size fits all
approach because the various infrastructure
projects have unique needs. The template is
intended to be flexible and allow for easy
expansion and contraction to accommodate the
needs of the agencies while not overly burdening
the community. Ultimately, the business plan is a
valuable tool for the community to use, not just
another agency hoop to jump through.

The template is designed for the community to
be able to easily move through each section and
build the plan specifically for that project in that
community. The guidebook will help the 
community gather, sort and organize the required
information and then provide a step by step
guide on how to complete each section of the
plan. Included in the package is a completed
sample plan to show what a completed plan may
look like. 

“. . . the goal is to

allow the community

to develop its own

business plan in an

easy to follow and

logical format . . . “

Business Plan Guidebook



TA
B

L
E

 O
F 

C
O

N
TE

N
TS

. . . . . . .

Table of Contents

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Business Plan Checklist . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2

Section 1 Executive Summary. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3

Section 2 Community Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

Location . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

Population Served . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

Transportation Available . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

Current Infrastructure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

Key Assumptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Section 3 Management Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Organizational Chart . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  . . . . . . . . . 6

Staffing and Training . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Key Personnel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  . . . . . . . . 7

Key Assumptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  . . . . . . . . 7

Section 4 Financial Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Revenue Source . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Estimated Annual Expenses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Operations and Maintenance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Repairs and Replacement  . . . . . . . . . . . . . . . . . . . . . . .  . . . . . . . . 9

Annual Profit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Annual Estimated Operating Cash Flow. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Key Assumptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Section 5 Capital Replacement Schedule . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Funding . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Key Assumptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Section 6 Legal Authority & Issues . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .14

Ownership . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Ordinances Related to the New Project . . . . . . . . . . . . . . . . . . . . . . . . . . .14

Special Permits, Licenses and Regulations . . . . . . . . . . . . . . . . . . 14

Key Assumptions . . . . . . . . . . . . . . . . . . . . . . . .  . . . . . . . . . . . . . . .14

Business Plan Guidebook



.
. .

. . . .

TA
B

L
E

 O
F C

O
N

TE
N

TS
. . . . . . .

Section 7 Interagency Relationships . . . . . . . . . . . . . . . . . .  . . . . . . . . 15

Involvement of Other Agencies . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Phase of a Larger Project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Key Assumptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Section 8 Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Wrap-up . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Timelines . . . . . . . . . . . . . . . . . . . . . . . .  . . . . . . . . . . . . . . . . . . . . . 17

Effect on Community . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Key Assumptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

Computer Tips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

To Customize the Business Plan Template . . . . . . . . . . . . . . . . . . . . . . . . . 19

Using the “Replace” for Quick Edits . . . . . . . . . . . . . . . . . . . . . . . . 19

Inserting Photos or Art . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

Text Boxes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Working with Styles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

How to Create a Table of Contents . . . . . . . . . . . . . . . . . . . . . . . . . .23

How to Insert a Table from an Excel Data File . . . . . . . . . . . . . . . . 24

How to Manipulate the Organizational Chart in Section 3 . . . . . . . . . . . . .26

Resources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .27

State of Alaska Website . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

AEA/AIDEA Resources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

BLM Resources . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

DOL Resources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .27

USDA Resources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

VSW Resources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

Various Resources for Business Plans . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Glossary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .30

Terms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .30

Acronyms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .32

Glossary of Excel Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

Business Plan Guidebook



IN
TR

O
D

U
C

TI
O

N

. . . . . . .

Business Plan Guidebook



.
. .

. . . .

IN
TR

O
D

U
C

TIO
N

. . . . . . .
INTRODUCTION
. . . . . . .
WHAT IS A BUSINESS PLAN?

An engineer works from blueprints to build the
facility that creates a utility system, washeteria,
clinic or tank farm.  The blue print gives the
engineer a detailed structure and a plan for
construction.  You can imagine what a mess the
washeteria would be if it were built without any
blueprints or plans. 

Management of that utility system, washeteria,
clinic or tank farm also needs a detailed structure
and a plan for operations.  That detailed structure
and plan for operations is the business plan.  The
business plan gives the management structure
and a plan to work from.  Otherwise a mess, or
poor management, is bound to follow.  

A business plan is written for a specific date and
situation.  It is however, a living document.  It is
a flexible, dynamic document that changes,
grows, and needs to be updated on a consistent
basis.  In other words, like laundry and dishes, it
is never completely done, it is worked with.  A
business plan is not a finished document, it is a
working document.

Structurally, a business plan consists of a
narrative (discussion) and financial spreadsheets.
The narrative is the body of the business plan.
The discussion, or narrative, will tell the reader
how and why you are proposing to build the
facility.  The discussion will also convince the
reader that you can manage the facility
profitably, and can sustain it over a period of
time.  The spreadsheets will present the financial
figures that support your narrative.

WHY SHOULD YOU DO A

BUSINESS PLAN?

The purpose of a business plan is to demonstrate
to the funding and regulatory agencies that your
organization has the financial and managerial
ability to manage the services and maintain the

facilities.  A good business plan shows that you
have the understanding of what constitutes sound
business management. 

Without good management, even the best utility
will eventually fail.  There is a direct relationship
between the lack of planning and failure.  That is
why lending institutions and capital funding
agencies require a business plan.

For you, the real value of doing a business plan is
the research and planning involved not
necessarily the final document.  The act of
planning helps you think and work through the
project thoroughly.  

It typically takes several weeks to complete a
good plan.  Most of that time is spent researching
and accumulating the financial information.  Take
time to do the job properly.  It takes time to
create a good plan, but a good plan can help you
avoid costly mistakes.

HOW CAN THIS GUIDEBOOK AND

TEMPLATE HELP YOU?

Creating a business plan is time consuming and
can be difficult if you have no guidance or
structure to build from.  The Business Plan
template was created to give you the structure for
your business plan.  This guidebook gives you
direction on how to use the template and
recommendations on how to write the plan. 

Although it is a standardized template, business
plans may differ significantly from one to
another.  What is needed for your business plan
is, first working through the steps and research
needed to complete your plan; and second
providing the information the funding agency
requires.
In completing the business plan template, work
through the sections in any order you like, except
for the Executive Summary which should be
done last.  Skip any portion that does not apply to
your type of organization.  When you are through
writing all the sections, edit them into a smooth
flowing narrative.

1
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Keep detailed notes on your sources of
information, financial data, and assumptions you
are presenting. 

Business Plan Checklist

To assist you in organizing your materials and
writing your plan, we have presented a plan
checklist below.  This checklist is also available
on your diskette/CD as a separate word document
named “Business Plan Checklist”.  Modify and
print the checklist as a preparation aid. 

Use the checklist to monitor your progress and
check for completeness.

STEPS
• Go through each chapter or segment of the
business plan and list the data needed to
complete each part.  Here is a preliminary, or
partial, listing of data you should collect for
completing the business plan:

◊ Community census report 
◊ Monthly financials
◊ Year to date numbers
◊ Current budget
◊ Next year's budget draft, if available
◊ Year end statements for the previous 2 

years
◊ Your certified financial statements
◊ Any ordinances relating to the project
◊ Personnel policies and procedures 

manuals
◊ Current organization charts
◊ Job descriptions
◊ List of infrastructure in the community
◊ Contracts associated with the project
◊ Any MOU or memos of agreement
◊ Agreements or resolutions
◊ List of project components for Repair 

& Replacement (R&R) schedule
◊ Grant agreements or conditions
◊ Agency correspondence relating to the 

project

Organize and sort data according to topic and
chapter

• For the financial chapter you need:
◊ Monthly financials
◊ Budget
◊ Year end statements
◊ Certified financial reports

• Write one chapter at a time. Easy ones first like   
Community Overview.
• Finish the document with the executive
summary.
• Refine each chapter making sure all chapters
are consistent and refer to the same info, use the
same numbers, etc.
• Have someone who hasn’t been in the middle
of writing the plan review it. Also, possibly send
it out for agency review like Rural Utility
Business Advisor (RUBA) program or Village
Safe Water (VSW) prior to submission to the
requesting agency.

2
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Section One

EXECUTIVE SUMMARY
. . . . . . .
The executive summary is the most important
section of the business plan.  Include everything
you would cover in a five-minute interview.
Explain the fundamentals of the project:  what it
is, who your customers are, who the owners are,
and what you think the future holds for the
project and the community.  Make it enthusiastic,
professional, complete and concise. 

As the name of the section says, it is the
summary of the whole plan.  This is the section
that will bring all the other sections together  to
present the “big picture” on how your community
will manage this utility to make it sustainable.

The executive summary should be two pages or
less.  It should be prepared after all of the other
sections have been completed.  

Your summary needs to describe the goals of the
project and their relation to the organization:

• “Sell” the idea that the proposed project is
realistic, needed and sustainable.

• Define the scope of the project and if the
project is a large project, define the phases and
timelines for each fiscal year.

3
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“We all seek

‘sustainability’ - the notion

that what we help build

makes sense, is

economically justifiable

and has an acceptable

life span. The Business

Plan explains how a

community plans to

achieve all that. We will

not fund projects without

good business plans

because failure to plan is

the same as planning to

fail.”

- Jeff  Staser
Federal Co-chair, Denali

Commission
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Section Two

COMMUNITY OVERVIEW
. . . . . . .
Your community is your marketplace.  If you are
the sole provider of a service, you may not think
it is important to promote or advertise your
services.  Experience shows you need the
community and customers to “take ownership” of
the utility or service.  Otherwise, customers will
not feel it is necessary to pay for the service or
care for the facility. 

When discussing your community, be as specific
as possible; give statistics, numbers and sources
to back up your statements. 

Much of the information regarding your
community is available locally. However, if
available, use online sources for other
information.  

Location

Describe the location of the community.  
• Relative to entire state (i.e. south central,
interior, etc.)  
• Relative to major rivers or mountains
• Miles from closest major municipality

Population Served

Describe the population that will be served by the
project:
• What comprises the local economy?
• What is the stability of the economy?
• How many households are in the community
and how many of those are going to be served by
the new project?
• What is the current demand for the proposed
utility?
• What about anticipated growth, and population
trends?
• Does the community have seasonal activities or
increased employment?

Briefly explain who needs the services and why.  

SELECTED STATISTICS

Discuss selected statistics that demonstrate the
organization’s ability to provide services.
Demographic and historical data for a community
is provided on the Alaska Community Profile
Website.  See the Resources Sections in the
computer tips area of this guidebook for more
details on available resources.

The schedule below was completed with
information from the DCED web site.  You can
find this table in the Excel schedule on the
Statistics Tab:

Transportation Available

Describe transportation to the community and
within the 
Community:
• Primary transportation to the community
• Local road system
• Vehicles and equipment available locally
• Shipping cost

Current Infrastructure

Describe the facility that is being repaired or
replaced by this project,
• Condition
• Adequacy

4
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Population
2000
1990
1980
1970
1960
1950

Housing (2003 Data)
Occupied Housing
Vacant Housing Due to 

Seasonal Use
Other Vacant Housing
Average Household Size

Economic Date (2000 Data)
Unemployment Rate
Median Household Income

Population
555
501
412
340
228
194

137

7
9

4.05
0

15.40%
$25,156.00
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• Suitability for continued use
• Other pertinent information
• Describe other related utilities
• Bulk fuel capacity
• Power plant size and capacity
• Sewage lagoon size and capacity
• Discuss how other utilities relate back to the
proposed project

Include third party documentation if available.
These are documents like engineering reports,
community plans, or outside agency reports.

Key Assumptions

List your key assumptions.   These are beliefs
that you have related to the community that you
are “taking for granted” or “assuming”.  It may
be that while one industry is growing, another is
stable or even on the decline.  Explain all
assumptions here.  

Examples of community related assumptions are: 
• Demographic information obtained from the
state is reliable.
• Current population size, number of households,
commercial and business establishments (using
actual count data) will be used to generalize the
estimated number of users.
• Population will continue to grow at the present
rate.
• Transportation into and out of the community
will not change.
• Related utilities will not have significant rate
increases within the foreseeable future.

5
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Section Three

MANAGEMENT STRUCTURE
. . . . . . .
This section discusses the different elements of
staffing and training.  It is important to
demonstrate that you have adequately trained
staff to manage the construction phase as well as
ongoing services.

Discuss topics that will affect the future
management and operation of the utility like:
• number of employees needed
• type of labor
• how and where you will find new employees
• quality of the existing staff
• pay structure
• training requirements
• projected new positions

You need to clearly show who is responsible for
each task associated with operating the utility.
Are schedules and procedures in place?  Do you
have written job descriptions for employees? If
you don’t have them, take the time to write them.
Will you use contract workers as well as
employees?  Have all tasks written out and then
assign employees to the tasks.  This assures tasks
are identified and helps you address time
constraints and skill abilities of present staff as
well as possible training needed.

Organizational Chart

An organizational chart describes in picture
format the supervisory and reporting
relationships in a business. For example the clerk
is supervised by and reports to the City
Administrator and the City Council.  

It can also depict your coordination relationships.
The benefit of an organizational chart is it creates
a better understanding of the supervisory
responsibilities, relationships, and flow of
information in your organization.

Positions shown on the chart are not dedicated
entirely to the operations of this project.  Each of

the positions performs other functions for other
projects or for the organization as a whole. 

Complete the following organizational chart to
illustrate staff relationships of the proposed
project:

Give a brief description of the duties for the
following positions that will be associated with
the operation and management of the utility.
Some examples would be:
√ Tribal/City Administrator – 
√ Chief Financial Officer/ Treasurer – 
√ Clerk – 
√ System Operator – 

Staffing and Training

Describe the staffing of the project.  An example
is the administrator, outlining his/her duties and
powers.  This should be complete for all
employees, especially key personnel. 

ADMINISTRATOR DUTIES

Discuss in outline format the duties of the
administrator:

Supervision
Authority
Delegation

Include a draft ordinance if you don’t already
have an existing one establishing the powers and

6
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Assistant

Public Works
Advisory

Entity

Customer

Administrator
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duties of the City/Tribal Administrator, if
appropriate.

TRAINING
Discuss any training programs that will be
required.  These programs may be in-house,
provided by funding agencies, or part of a
certification program provided by the State.
Discuss possible cost, scheduling, staff involved,
and what benefits will be derived from the
training.

Key Personnel

Who are key personnel?  Key personnel are
employees, contractors, or advisors that are vital
to the project.  Their participation is critical to
the success of the operations.  Discuss who will
be the key personnel of the project during the
construction phase and after construction for
ongoing operations.  

Key Assumptions

What are your key assumptions used related to
staffing and training?  Again, assumptions are
things you believe or assume to be true.

Examples of employee related assumptions are:  
• cost of training new employees will be constant
• training will be available
• employees will be stable and there will
not be significant staff turnover
• key personnel will be available for hire.

7
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Section Four

FINANCIAL DATA
. . . . . . .
The financial data section provides information
on how the project will receive revenues,
expenditures, and what anticipated maintenance
costs may be.  This section requires significant
research and data compilation.  

It is important to keep the documents that you
used to reach your final figures in the Excel
schedules. These supporting documents will help
show the funding agencies how you reached
those final figures and not just the numbers
themselves. 

It is recommended that the community insert a
comment that the amounts in the financial data
sections are estimates.  

Revenue Source

All enterprises should be self-supporting.
Revenue to support the proposed improvements
normally comes from user fees including
commercial, residential, and school user fees.
Oftentimes other community-generated revenues
such as sales tax and gaming receipts may be
necessary to supplement user fees.  

Revenue generated from user fees funds the
annual operations and maintenance costs to
operate the system.  Estimate needed revenue
based on the projected annual costs for the
preferred system.  Based on these projections, the
annual revenue requirement for the project is
detailed below.

A sample of these revenue sources is listed in the
graph below.  The table can be found in the Excel
workbook under the Revenue tab.  

8
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Revenue Source
Residential User Fees
Small Commercial Users
Large Commercial Users
School User Fees
User Fees from Washeteria
User Fees from Fish Processing Plant
Water Sales (per gallon)
Local Capital Contribution

Total Revenue

$105.00

$5,000.00

$5,000.00
$0.05

130

1

1
135,000

85%

100%
100%
100%
100%

$138,411
$5,000

$0
$45,000
$10,000
$20,000

$6,750
$40,000

$265,161

Monthly 
Rate

# of
Customers

Collection
Rate

Yearly
Revenues
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Estimated Annual Expenses

There are two cost categories important to the
ongoing operation and upkeep of the project –
“Operations and Maintenance” (O&M) and
“Repairs and Replacements” (R&R).

Operations and Maintenance

There are a number of expenses relating to the
operations.  Operations and maintenance items
are defined as expenses that are incurred on a
regular basis to sustain the operation of the
utility.

The following are operations and maintenance
samples for the yet to be designed project.  This
schedule was prepared in the Excel workbook.
These are summary numbers. You will find a
more detailed list in the workbook in order to
arrive at these summary figures.

Repairs and Replacement

The organization will incur expenses relating to
the repairs and replacement of the system.
Repairs and replacement (R&R) costs are those
expenses defined as items costing more than
$1,000 and not replaced on an annual basis.
R&R costs are capital costs that will be
depreciated over the useful life of the item rather
than expensed in the year incurred.  

The goal of the repairs and replacement account,
as shown in the schedule above, is to ensure that

you have set aside adequate funds to repair items
that are going to wear out over a short period
(less than seven years).  To compute this amount
needed for repairs and replacement you estimate
the amount of “wear and tear” that equipment has
over time.

Depreciation is an accounting method to estimate
the “wear and tear” that equipment will reflect
over time.  Any asset has a “life”, where it has
decreasing value until it becomes completely
worn out or obsolete; then it is worthless.  The
most common type of depreciation is called
“straight line” depreciation.  Straight-line
depreciation divides the cost of the asset by the
number of years it is estimated to be operational.
Different assets have different useful lives.  A
washer may last three to five years, whereas a
boiler may last ten to fifteen years.  

An expense is an item that when it was paid, it
had already been used up. When you pay rent or
utilities, there is nothing left from the payment so
it is an expense.  There is no residual value.  On
the other hand, when you purchase a desk and
pay for it, you have a real object, the desk. That
object has value after you pay for it so it is not an
expense, it is an asset. 

The following example schedule presents
depreciation for the various items of a yet to be
washeteria project.  This schedule was prepared
on the Excel worksheet and the summary was
pasted to this location.  For each of these line
items, the attached schedule shows more detail.
If the schedule is “linked” to the business plan,
any changes to amounts will automatically
update the plan document.

9
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Expense Category           Annual Estimate
Administration
Labor
Miscellaneous Materials
Electricity
Heating Fuel
Water Treatment
Sewage Treatment
Insurance
Repair and Replacement Account
Capital Replacement Account

$23,400
$39,600
$5,940

$10,634
$20,312
$95,265
$9,527
$1,000

$17,166
$35,660

$258,504
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TIME LINE / DESIGN LIFE OF

MAJOR COMPONENTS

Knowing the design life of the facility you build,
as well as the equipment in the facility, will
provide you with a fairly accurate idea of the
time line for replacing the facility as well as the
equipment within it.  For example washers,
dryers, boilers, and bathroom fixtures all have
different useful design lives.  Their design life is
to last a certain length of time with normal to
excellent maintenance before they wear out.  The
building itself may last 30 years or more.  There
is no washer that will last as long as the
buidlding itself, especially with heavy
commercial usage.  

In order to maintain or sustain the total facility,
you should know approximately when you will
need to replace the equipment and the building.  

Annual Profit

The annual profit is all sources of revenue, less
all expenses and amounts set aside for
replacements (both capital and repair).  

The schedule below is very similar to the cash
flow schedule shown on the following page.  The
two schedules show the same information.  This
schedule however is formatted to show the
income or loss of the project before the
community contribution.  Because it is important
that utility projects be self supporting and the
project sustainable, the amount of profit or loss
before the contribution is important.

Annual Estimated Operating Cash
Flow

Annual estimated operating cash flow reflects the
annual flow of money received minus the cost of
operations over the course of a fiscal year.  These
costs include items that are not fully tax
deductible such as capital expenditures and loan
repayments.  You will notice that the “bottom
line” of $6,657 is the same as the prior profit
schedule.  This schedule demonstrates that at the
end of the year you will have $6,657 more in the
checking account than you began with.

10
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Washer
Dryers
Pumps
Boilers
Heat Exchangers

4
3
4
2
5

5
5
3
8
5
1
1
1
1
1

$1,400
$1,200
$8,000

$14,000
$1,159

x
x
x
x
x
x
x
x
x
x

÷
÷
÷
÷
÷
÷
÷
÷
÷
÷

=
=
=
=
=
=
=
=
=
=

$1,120.00
$720.00

$10,666.67
$3,500.00
$1,159.00

-
-
-
-
-

$17,165.67

Description of Equipment      Number    x      Cost     ÷ Useful Life  =   Depreciation        

Total amount that should be set aside annually for major R & R costs

Revenue  
Residential User Fees
Small Commercial Users
Large Commercial Users
School User Fees
User Fees from Washeteria
User Fees from Washeteria
Water Sales

Expenses
Annual Operation and Maintenance Costs
Annual Repair and Replacement Costs
Capital Replacement Account

Net Operating Income (Loss)
Net Operating Income
Plus: Local Capital Contribution
Annual Estimated Profit

$138,411
$5,000

-
$45,000
$10,000
$20,000
$6,750

$225,161
Expenses

$205,678
$17,166
$35,660

$258,504
($33,343)
($33,343)

$40,000
$6,657
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Key Assumptions

What are your key assumptions used related to
financial data?  

Examples of financial assumptions might be:  
• Revenue will be generated from user fees for
water, sewer and laundromat services.  There
may be an outside source of funding for
operations, like an ANHB grant for maintenance
on a limited and selected basis.  These will not
be considered in the preparation of the projected
revenues or budget
• An inflation factor of 1% per year will be
calculated into the of cost projects but not the
revenue of projects
• This analysis will not include any programs or
revenues for retrofitting residents’ housing for
plumbing
• There will be 5% to 10% uncollectible fees and
write-offs.  This percentage should be adjusted
based on actual experience.  This provision is not
accounted for in the revenue projections

11
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Cash Sources  
Residential User Fees
Small Commercial Users
Large Commercial Users
School User Fees
User Fees from Washeteria
User Fees from Fish Processing Plant
Water Sales (per gallon)
Local Capital Contribution

Cash Uses
Annual Operation and Maintenance Costs
Annual Repair and Replacement Costs
Capital Replacement Account

Excess (Shortage) of Cash over Expenditures

$138,411
$5,000

-
$45,000
$10,000
$20,000
$6,750

$40,000
$265,161

Expenses
$205,678
$17,166
$35,660

$258,504
$6,657
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Section Five

CAPITAL REPLACEMENT

SCHEDULE
. . . . . . .
A capital replacement fund is the amount of
money that should be saved each year to
completely replace the project at the end of its
estimated useful life or design life.  

Many communities think that they don’t need to
save up any money to replace a utility, believing
that the State will come back and rebuild for
them.  State agencies increasingly are making an

effort to educate communities in sustainability
and requiring business plans to demonstrate a
community’s ability to sustain a facility once it’s
built.

Funding

The following schedule demonstrates a $10
million project that will be replaced in thirty
years.  In this case $178,301 annually needs to
be set aside for the full replacement, or $35,660
for a 20% down-payment on replacement, used
in these schedules.  

This schedule is on the attached Excel Workbook
under the tab Capital Replacements.
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Project Replacement Costs                               Capital Replacement Fund Balance

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30

$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000

$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000

$0
$35,660
$72,747

$111,317
$151,430
$193,147
$236,533
$281,655
$328,581
$377,385
$428,140
$480,926
$535,823
$592,916
$652,293
$714,045
$778,267
$845,058
$914,520
$986,761

$1,061,892
$1,140,028
$1,221,289
$1,305,801
$1,393,693
$1,485,101
$1,580,166
$1,679,032
$1,781,854
$1,888,788

$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$1,069,806

$0
$1,426
$2,910
$4,453
$6,057
$7,726
$9,461

$11,266
$13,143
$15,095
$17,126
$19,237
$21,433
$23,717
$26,092
$28,562
$31,131
$33,802
$36,581
$39,470
$42,476
$45,601
$48,852
$52,232
$55,748
$59,404
$63,207
$67,161
$71,274
$75,552

$930,194

$35,660
$72,747

$111,317
$151,430
$193,147
$236,533
$281,655
$328,581
$377,385
$428,140
$480,926
$535,823
$592,916
$652,293
$714,045
$778,267
$845,058
$914,520
$986,761

$1,061,892
$1,140,028
$1,221,289
$1,305,801
$1,393,693
$1,485,101
$1,580,166
$1,679,032
$1,781,854
$1,888,788
$2,000,000
$2,000,000

Equivalent Annual Cycle Cost
Inflation rate: 0.0%                                                   Reinvestment Rate:   4.0%

Total Assets Start of Year               Annual                  Interest             End of Year

Year    Inflated Cost            Asset Cost                    Balance                  Deposit                Earnings               Balance

20% of Total
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FUNDING OF MAJOR COMPONENTS

How will the major components of the project be
financed?  Will there be matching funds
required?  Will other agencies contribute money
used for matching?

AVAILABLE RESOURCES FOR THE

INFRASTRUCTURE

Discuss the resources presently available in the
community.  Is there electric power located at the
site, or will poles and lines need to be
constructed?  What water and sewer utilities are
presently available?  Is there a road to the site or
will one need to be constructed or upgraded?

EMERGENCY AND CONTINGENCY

PLAN NEEDS

What are the emergency/contingency plans for
the utility?  What if electric power is out for an
extended period of time?  Are there alternate heat
sources?  What emergency plan do you have if
the water or sewer freezes in mid-winter?  What
will you do if you have a boiler malfunction?  Do
you have a written plan in place to address
possible problems?

Key Assumptions

List your key assumptions related to capital
replacements, such as availability of parts and
availability of services.  

Examples of repair and replacement assumptions
are:  
• Repairs and maintenance will increase as the
plant system ages and the plant size increases.
• This analysis does not address a rebuild of the
system at the end of its useful life or a failure of
the system from design, product failure or
obsolesce.
• Parts will be available.
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Section Six

LEGAL AUTHORITY &

ISSUES
. . . . . . .
Ownership

Identify the owner of the new project. Clearly
state who owns it and who will manage it, etc.
This information may be repeated in other
sections like the management section. If there is a
joint ownership or management agreement in
place, what are the provisions? Attach a copy or
proposed copy of any contracts dealing with
management or joint ventures.

Ordinances Related to New Project

Review your utility ordinance.  Address utility
rates, and collections.  You may have to change
the ordinance to reflect the new project.  If your
ordinance refers to a flush haul system and you
are getting a piped system, appropriate changes
need to be made in the ordinances. Rates and the
rate structure need to be reviewed and changed to
match the new project (basically a review and
matching process so the ordinances reflect the
new system).

Special Permits, Licenses and
Regulations

Are there any special permits involved with your
project (i.e. If you’re getting a bulk tank do you
need a coast guard permit?  You probably do,
even if you are inland). Agencies are a good
source of this kind of specific information. The
project managers and engineers will also be able
to advise here. Do you need a certificate of
public convenience and necessity from RCA? If
you need one, do you have it or are you applying
to get it? Are you currently regulated?

Does your community have zoning issues that
will have to go through a planning and zoning
commission prior to construction? 

Key Assumptions

List your key assumption related to legal
authority and issues.  

Examples of legal assumptions are:
• Current providers of water and sewer utilities
(if another organization presently operates any
portion of utilities) will be transferred. 

14
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“Providing an

appropriate legal

foundation to any

project is an important

step in eliminating

problems both during

construction and in

the future operations

of the facility.”
- Scott Ruby

RUBA Program Manager
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Section Seven

INTERAGENCY

RELATIONSHIPS
. . . . . . .
Involvement of Other Agencies

INVOLVEMENT IN CONSTRUCTION

PHASE
• Who is the granting agency? 
• Are there multiple granting agencies for the
same project?
• Are the monies being mixed between agencies
for the same project?
• Are all the grant conditions being met for each
portion of the project?

If you mix VSW money, DCED money, and
Denali Commission funds all in an effort to
upgrade your washeteria and build a new water
plant, all those agencies need to be shown as part
of the overall project. 
• If engineers and contracting firms have been
awarded contracts on some phase of the project
who are they? 
• Are you getting outside assistance from anyone
like RUBA, DEC, management consultants, or
accountants?

This section will allow readers to understand and
show how all those involved fit into the project.

Discuss involvement of all funding and oversight
agencies for the construction of the project.
Discuss who manages the construction, hiring,
purchasing, and scheduling  Will there be
accounting for the project to be managed by your
community, an agency, or an outside organization
hired by the agency?   

INVOLVEMENT IN ONGOING

OPERATIONS

During the different phases are the same players
going to be involved or are their contracts limited
to a certain time period with new players in later
phases? Are you counting on the remote

maintenance workers (RMW’s) to be there down
the road for ongoing issues? Do you even know
if you have RMW’s? What about regulatory
agencies? What about PCE for an electric plant?
If your project is to provide electricity to the
community or an electric utility upgrade, have
you contacted AEA to see what effects PCE may
have on your projected costs?

Who will be involved in the ongoing operations
of the project?  Are reports required, and how
often will the reports need to be submitted?
Discuss the involvement of all funding and
oversight agencies in the ongoing operations of
the enterprise.  

REPLACEMENT AGENCIES

What agencies or funding sources have you
identified as a potential source for replacing the
utility at the end of the design life? 

REGULATORY AGENCIES
• Who are the regulatory agencies you are
required to report to?
• What are your responsibilities for reporting to
these agencies? 

Discuss the responsibilities of the community and
the regulatory agency here.

Phase of Larger Project

A phased project requires thought to go into each
phase and construction year of the project.  A
phased project needs to be included in the utility
master plan or whatever guiding document you
are using during the completion of the project.
The benefit of this approach is to examine each
phase of the project construction year and
determine other impacts.  For example, if in two
years, the new electric plant you are building in a
phased project  is going to require an extra
million gallons of fuel to operate, do the bulk
fuel people know that before they build your new
tank farm with only a 250K gallon increase? 

Many specifics are not known at the time you
write a business plan.  However, it’s an
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opportunity to start thinking about your
community and impacts the new construction will
have on available services.  If you start asking
questions early, it will reduce problems down the
road.

Discuss the phases of the project.  What segments
will come on-line at what point?  When will
customers begin to be charged for services or
when will charges need to be increased?  

Key Assumptions

List your key assumption related to interagency
relationships.  

Examples of assumptions are:
• Residential and commercial establishments
(except for current users) will not be hooked up
until the following has occurred:

a) each phase is fully complete
b) the community has accepted the 

project
c) establishments have been retrofitted to 

accommodate plumbing
• Revenues will be generated according to the
project completion date schedule with the final
construction phase being completed in the year.

16
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“By leveraging our funds

and combining our

individual talents with the

agencies of

state/federal/local

governments in conjunction

with our partners from the

non-profit world, we are

able to do a much better

job in the delivery of

service to the residents of

rural Alaska. Standardizing

such things as Business

Plans improves our ability

to be more efficient and

effective as we strive to

meet our individual

objectives.”
- Bill Allen

State Director USDA



Effect on Community

Discuss the impact the new project will have on
the community.  How does fuel at the next
village impact construction/sales?  If the
community is making a contribution to the
sustained operations of the project, where will
the money come from?  

How will the revenue sources commit to the
business plan?  Will there be some “agreement”
for payment and continued need of services,
particularly with schools, fish processing plants
and other major users?

It is very important to break down the income in
the community and present proof of the
continued sustainability of the project.

COST OF LIVING/RESIDENTS

ABILITY TO PAY

It is important to discuss how a surcharge for
new services will affect residents’ ability to pay.  

The schedule below presents the community-
wide income per household. It shows the related
expenses of each household before the user fee
that would be required to sustain the new project.  

.
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Section Eight

SUMMARY
. . . . . . .
This section of the business plan summarizes
other elements of the project not discussed in the
prior sections.

Wrap-up

How are you going to wrap up the project?  What
will be considered completion?  When do you
estimate that the project will reach wrap-up stage,
and what special reports need to be submitted in
order to complete the reporting requirements?

Timelines

Discuss any important timelines and deadlines
related to your project.  Present how the different
deadlines are to be met by all parties involved.

17

Description Average Rate Times Amount
Incomes Per Household
Median Household Income
Expenses Per Household
Rent
Food
Electricity
Fuel
Water and Sewer
Airfares
Clothing
Gifts/Holidays
Other

$425
$175
$150
$800
$105
$160
$200

$100

12
52
12
4

12
2

12

12

$5,100.00
$9,100.00
$1,800.00
$3,200.00
$1,260.00

$320.00
$2,400.00

$500.00
$1,200.00

$24,880.00

$276.00

$25.156.00
$25,156.00

Surplus (Deficit)

This information was obtained from the State of Alaska Community Database website.  Directions to
accessing the Community Database site are presented in the resources section of computer tips.  

Business Plan Guidebook
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Key Assumptions

List your key assumptions related to wrap-up,
timelines and effect on community.  

Examples of some key assumptions related to
community impact are:
• Income from State of Alaska statistics is correct
• There will be no significant increase in the cost
of air and freight transportation
• This document has not considered the effect of
natural disasters such as fire, flood, and
earthquake.

18
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COMPUTER TIPS
. . . . . . .
Most of the computer tips shown on the
following pages are optional.  You can paste the
schedules from the Excel spreadsheets into your
business plan template.  

You can include pictures, draw text boxes, paste
tables, etc.  It will improve your presentation.
But you aren’t required to.  A business plan is,
first and foremost, a written document that
outlines your future plans.  It does not need to be
fancy to be successful.  

If you are a beginning computer user and if these
suggestions will only cause you stress, then use
the template as a typing page.

Additionally, different versions of Word and
Excel have different features.  If you are working
on an older version of Word or Excel (especially
versions older than 98) you may not have the
feature as presented.  

To Customize the Business Plan
Template

If you want to keep the business plan template
for future use with other projects, it is important
to open the template, immediately rename the
template, and save it under the new name.  To do
this:
• Go to the File menu on menu bar of your
Microsoft Word program
• Go to “Open” on the pop-up menu
• You are now in the “Open Screen”
• In the “Look In” data field, click on the down
arrow.

• Locate the CD Rom drive for CD’s or the “A”
drive for diskettes and click on it
• The listing of files will appear
• Select “Template” on the list and double click,
or highlight and click on the “Open” button
• The document will open on your word program
• To save the template as a new document
• Go to the File menu
• Go to “Save As” on the pop-up menu
• You are now in the “Save As Screen”
• The “File Name” field will have DCED
Business Template highlighted; overwrite this
with the new file name.
After this point when you open your Word
program, the new document will automatically
appear on the listing of most recent files at the
bottom of the File menu.

Using the “Replace” for Quick
Edits

You can quickly change [Community Name] to
your community name everywhere in the
business plan using the replace function.  
• On the Edit menu, click on Replace.  
• This will display a dialog box on the screen.  
• In the “Find what:” field type [Community
Name], include the brackets 
• Go to the “Replace with:” field and type in
your community name.  
• Click on the Replace All button.  
• The program will notify you of the number of
replacement made.  
• There should be 10.  

You can exit now, by clicking on the X box in
the top right corner of the screen, or do a second
replacement of [Project Name] to your project’s
actual name.
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Inserting Photos or Art

A picture can speak a thousand words.  It is
important to use them.  Learning how to insert,
size, and crop pictures within a Word document
can take several attempts.  However, once you
master adding artwork, other Word documents
you prepare can be illustrated easily.  It should
take between five and ten minutes to insert a
picture.  Using a picture can quickly demonstrate
to the reader or reviewer the current condition of
the facility. This will also show why you need a
new one.

CLIP ART

Your Word program has hundreds of pictures it
calls “Clip Art”.  These pictures may be used
without obtaining permission.  They may add to
your plan, but be careful not to “over decorate”.  
You can insert clip art in the template. To do so: 
• Click where you want to insert the picture. 
• On the Insert menu, point on Picture, and then
click Clip Art. 

• Locate the picture you want to insert, and then
click 
The newer versions of clip art have Search Text,
where you will type in the type of clip art you
are looking for.  Older versions have pictures
categories.  You will need your Word diskette in
the “A” drive for many of these pictures to load.
They are not saved to your hard drive.  

PICTURES FROM FILES OR DIGITAL

PICTURES

With digital cameras, it can be possible to take
pictures of the project and insert them into the
business plan.  Because there are numerous
cameras and downloading instructions for saving
digital pictures, this guidebook will not try to
address that process.

It is important to save these pictures on a folder
within your My Documents called My Pictures.
Your Word program will automatically look in
this folder for any pictures from files.
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To insert pictures from a file:
• Click where you want to insert the picture 
• On the Insert menu, point on Picture, and then
click From File
• Locate the picture you want to insert, and
highlight it by clicking on it. 
• Next, click Insert button 

PICTURES FROM THE WEB

Many pictures are available on the Internet
(Web).  To use a picture from the Internet, 

• Position your pointer on the picture 
• Right Click your mouse, 
• From the menu that pops up, select Save
Picture As.  

The Word program will save the picture in a
folder My Pictures.  Be sure to name a picture
with a descriptive name you’ll remember later.
• To access these pictures
• Click on Insert on the menu bar
• Click on Picture and From File
• The Insert Picture screen will display the My
Pictures folder
• Select the picture you want and click to
highlight
• Click on the Insert button
There are many wonderful Alaskan community
pictures on the State of Alaska, Department of
Community & Economic Development, and
Community Profile website. 

Be careful of copying pictures from the Web, as
many/most are copyright protected.  All pictures
on the Web should be assumed to be copyrighted
unless a notice shows it is in the public domain.
Copyrighted images can be used, but only with
written permission of the owner.

Text Boxes

A text box offers a flexible way of displaying text
and graphics; it is a container. You can move a
text box around, positioning it just where you
want it; you can resize it into a tall narrow
column or into a short wide column, or even
rotate it so that the text reads sideways.

TO CREATE A TEXT BOX

Go to the Insert menu, scroll down to Text Box,
and click.  A dotted line box will appear on the
screen, click anywhere in the box and drag to
create the size of box you desire.  

Double click inside the box, and you can begin to
type your message.  

RESIZE A TEXT BOX

To move a text box, select it so that it has either a
hatched or dotted border. Then, move the cursor
over the border of the text box until the pointer
becomes a four-headed arrow, and drag the text
box to its new location. 

MOVING A TEXT BOX

Sometimes you may want to move a text box
slightly in one direction or another, but you find
that using the mouse doesn't give you the degree
of control you want. You can achieve finer
control of movement by using the arrow keys on
your keyboard.

To do so, click anywhere in the text box so that
its borders become visible, and then click a
border to select the text box. Next, press the
arrow keys to move the text box. A single
keystroke moves the text box a single increment,
while holding an arrow key down keeps the text
box moving.

If granularity of movement is really important to
you and you want as much control as possible,
you can cover a lesser distance with each
keystroke by first zooming in on the document.
To cover a greater distance with each keystroke,
zoom out. You can zoom out or in by clicking
Zoom on the View menu.

Working with Styles

This document has been created utilizing
“styles”, a uniform formatting for different
elements of the document.  The different styles
are shown on the third row of the menu bars.
The description box shows what style is being
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used.  It should presently read “Body Text
Indent”.  This document has been formatted with
Arial type in several size fonts.  Arial is a clean,
professional looking font (word for typeface),
and is commonly used in documents of this
nature.

However, you may want to change this font for
your document.  To do so, go to the Format
menu and scroll down to Styles and Formatting.
A formatting text block should now appear on
your screen, to the right of the document. 

To modify or change the style, click on the right
side of the type box, and a menu will appear.
Select Modify.  On the modify screen, you can
change the font type to another from the Arial
font, or increase or decrease the size of the type.
You can also modify other elements.  There is a
Format button at the bottom of the screen.  This
will give you a number of choices.  There is a
“Font” to change the color, size and type of
typeset.  Paragraph will allow you to modify the
indentations, and margins.  Other choices (not
described here) will give other results.  
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How to Create a
Table of Contents

Click on the page below the
table of contents heading.
Go to the Insert menu, and
depending on the version of
Word you are using, either
click on Reference or Index
and Tables.  Click on the
Table of Contents tab.  

You will want to modify
how the table of contents is
formatted (how it looks).
Click on the Options
button.  In the Show Levels
field overtype “3” and
change it to “2”.    You are
now on a screen where you
will indicate what styles
(from above) are to be listed
on the table of contents.  Go
down the row of TOC
choices until you locate
“Chapter Title”; enter a one
in the level field.  Continue
down the listing until you
come to “Heading 1” and
change the level to “2”.
Delete the levels indicated
for “Heading 2” and
“Heading 3”.  When you
click on “OK” the table of
contents should appear.

.
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How to Insert a Table from Excel
Data File

The business plan template uses a number of
Excel tables and schedules to assist in the
preparation of the business plan.  The schedules
in Excel are linked together so that amounts
entered into one schedule reflect on another
where appropriate.  This will also help, because
when an amount changes in one schedule, the
amount will automatically change on all related
schedules, both on the Excel document and the
Word document.  

However, you may have to practice several times
to get exactly the result you desire.  

To insert a table into your business plan, first
confirm that both the Word program and the
Excel program are actively running.  The

“Business Plan Template” that you have saved
using the “To Customize the Business Plan
Template” section above should be active in your
Word program, and your “Business Plan
Template Excel Schedules” should be active in
the Excel program.  You should see each program
shown at the bottom of your screen on the action
bar.  

Tab through the different tables in the Excel
workbook until you locate the table you want to
present on the business plan.  Position your
cursor on the upper left corner (Cell A1) of the
table.  Click and drag to the lower right corner, so
that the entire table is highlighted.  Go to either
the menu bar or the toolbar and click on Copy.
This action will place your table on the
computer’s clipboard.
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Now return to the business template Word
document and locate the cursor where you want
the table to appear. Go to the Edit menu, scroll
down to Paste Special and click.  

You are now on the Paste Special Screen, as
shown below, click on the Paste Link button and
highlight “Microsoft Excel Workbook.  Click on
the OK button and the table should appear.  

25

Business Plan Guidebook

You can position the table in your document by choosing the right, center or left align buttons.  You can
also enlarge or decrease the size of the table by click on one of the corners until you see small black
boxes at each corner, now click and drag one of these boxes until the schedule is the desired size.  
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How to Manipulate the
Organizational Chart in Section 3

The positions on the chart can be moved,
renamed, or deleted. 

To move a box
• Click on the edge of the selected box and move
your mouse until  four little directional arrow
appear,
• Click and drag to wherever you want the box
located

To change the title within a box
• Click inside the box
• Click and drag over an existing title to select
• Delete
• Type new title in the blank box. 

To move or adjust the lines connecting boxes
• Click on the line; you now see two little circles
at the ends of the line selected 
• To move the line, move the mouse until the
directional arrows appear, and click and drag to
new location
• To increase or decrease the line, click and drag
on the circle at the end to resize.
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RESOURCES
. . . . . . .
There are numerous resources for information on
the Internet (alternatively called the Web). A few
listed below are primarily the different
departments that work with communities to
construct or maintain utilities.  

State of Alaska Website

The State of Alaska has a very informative
website for Alaskan communities.  It is the
“Community Database Online”.  

To access this database go to the Alaska website.
You can get there two ways:  1) Enter State of
Alaska in any search engine (Yahoo, Google, and
MSN) and this will display the State of Alaska
official website.  Click on this
website and you will go to the
State’s homepage.  2) Enter the
website address on the Address
field of your homepage.
www.state.ak.us/

On this page under the “Of Interest” heading is a
listing for Alaskan Communities, click on this
and you will go to a screen that lists a number of
communities.  On the bottom of the page you
will find Community Profiles listed.  When you
are on the website for Communities Profiles click
on Detailed Community Information then
select a community, select the data you are
searching for, and click on the Get Data button.
These tables and screens can be copied to be
pasted into your document, or the information
can be manually transferred to your Word or
Excel documents.  

AIDEA/AEA Resources

Alaska Industrial Development and Export
Authority/Alaska Energy Authority have both an
online newsletter and a website.  

The newsletter reports on the most current events
of AIDEA/AEA.  This website can be located by
typing in the acronym AIDEA/AEA into any
search engine.  The one used for this guidebook
is “Yahoo”.  

BLM Resources

U.S. Department of the Interior Bureau of Land
Management (BLM) is accessed by typing
“BLM” in the search engine and clicking on the
link, or typing in www.blm.gov in the address
field on your web browser.  The web site has
linked topics and a search listing that includes
Alaska.  To go directly to the Alaska BLM site,
type in www.ak.blm.gov in the address field. 

DOL Resources

Department of Labor unfortunately cannot be
located by typing “DOL” in the search engine on
your web browser.  “Yahoo” listed ten pages of
links beginning with the U.S. Department of
Labor.  Type in www.labor.state.ak.us as the
address.  This will take you to the website.  The
website has numerous links to different topics.  
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Alaska Native Tribal Health
Consortium (ANTHC)

The Alaska Native Tribal Health Consortium
(ANTHC) can be located by entering “ANTHC”
into any of the available search engines.

U.S. Department of Agriculture,
Rural Development (USDA)

USDA rural development offers financial and
technical resources for rural development
projects.

VSW Resources

Village Safe Water (VSW), a division of the
Department of Environmental Conservation, is
accessible through the State of Alaska website.
In the search field of the State website, type
Village Safe Water and several links will appear.
Click on the Village Safe Water link. 
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Various Resources for Business
Plans

State of Alaska Department of Labor and
Workforce Development (DOL)
http://www.labor.state.ak.us/home.htm

Topics:
• Employment statistics
• Census Data
• Employment Security Contribution (ESC) rates
and calculations
• Workers Compensation rates and history

State of Alaska Department of Environmental
Conservation (DEC)
http://www.state.ak.us/dec/home.htm

Topics:
• Environmental compliance and permitting
• Water and wastewater regulations
• Water and wastewater operator certification
requirements

Bureau of Land Management (BLM)
www.blm.gov

Topics:
• Federal land management
• Land status data

Alaska Industrial Development
Authority/Alaska Energy Authority
(AIDEA/AEA)
http://www.aidea.org/

Topics:
• Bulk fuel permitting
• Power cost equalization program
• Power plant operator training
• Bulk fuel operator training

State of Alaska Department of              
Community and Economic    
Development (DCED)
http://www.dced.state.ak.us/

Topics:
• Community census data
• Community profile information
• Rural utility business advising
• Local government assistance
• Land management and mapping

Regulatory Commission of Alaska (RCA)
http://www.state.ak.us/apuc

Topics:
• Utility operating certificates
• Utility rate analysis

State Department of Natural Resources (DNR)
http://www.dnr.state.ak.us/

Topics:
• State land ownership status
• Coastal management and permitting

Alaska Native Tribal Health Consortium
(ANTHC)
www.anthc.org

Topics:
• Water and waste water engineering
• Health Clinic construction
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GLOSSARY
. . . . . . .
Business Plan Guidebook

Listed below are terms and acronyms that you
have encountered in this guidebook. You may
want to use them when creating your business
plan.  

Terms

FINANCIAL

Appropriation -  Funds set aside for a specific
purpose.

Asset -  Properties and valuables of an
individual or organization including land,
structures, system improvements, equipment,
vehicles, inventory, receivables, investments, and
cash.

Audited Financial Statements -  Financial
statements that have been prepared following the
auditor’s review of financial information to
assess its fairness and adherence to generally
accepted accounting principles.

Auditing -  The review of financial information
to assess its fairness and adherence to generally
accepted accounting principles.

Balance Sheet -  A formal report of a business’s
financial condition on a certain date; reports the
assets, liabilities, and owner’s equity of the
business.

Breakeven -  A point at which revenue equals
expenses.

Budget -  A financial plan outlining what
resources an organization expects to receive and
where it will expend its funds for a given period
of time, usually one year.

Capital -  Items acquired or constructed with a
life expectancy of more than one year and having
a value greater than a set amount.  (Typically
$500.)

Capital Projects -  Projects that consist of
special programs or the construction of large
capital structures.

Cash Basis -  A system of accounting by which
all revenues are matched and reported on
statements when the cash related to the
transaction is received.

Cash Flow Report -  A financial statement that
shows a business’s inflows and outflows of cash
during a fiscal period.

Certification -  A process that the Alaska
Department of Environmental Conservation uses
to show the competence of operators of water
supply or wastewater systems.  (The certification
is based upon experience and examination
requirements.)

Certified Financial Statements -  Statements of
revenues and expenditures for a given period
accompanied by a resolution of the governing
body that the information is true and correct.

Corporation -  A publicly or privately owned
business entity that is separate from its owner
and has a legal right to do business in its own
name; stockholders are not responsible for the
debts or taxes of the business.

Depreciation -  Allocation of the cost of a
long-term asset to operations during its expected
useful life.

Effectiveness -  Having an intended or expected
effect, or producing a strong impression or response.

Efficiency -  Producing an effect with a
minimum of waste or effort.  Exhibiting a high
ratio of output to input.

Enterprise Fund -  The fund containing monies
set aside for the organization’s utility
expenditures. (Utility Fund)

Expense -  Payments or disbursements made to
others for goods or services.

Financial Capacity -  Having adequate financial
resources to continue operations and fund major
repairs.
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Financial Management -  The focus is on cash
flow and optimal use of current assets.

Financial Reports -  Financial information that
is compiled and prepared into a useful format.

Fiscal Year -  A twelve month period for which
an organization plans to use its funds.

Fund -  A sum of money or other resources set
aside for a specific purpose.

Fund Balance -  The worth of the organization.
The fund where all surpluses and deficits from
prior years accumulate.

Grants Fund -  Money received from an outside
source to provide a special program.  The money
is restricted to the program, and if unspent will
need to be returned to the provider.

Income Statement -  A formal report of
business operations covering a specific period of
time; also called a profit and loss statement or a
statement of income and expenses.

Inventory -  All goods and materials in stock for
use in operations.

Liability -  A debt or obligation of a business or
organization.

Liquidity -  The ease with which an item can be
converted to cash; the ability to pay debts when due.

Locally Generated -  Operating revenues
produced by an organization, not gained from
any outside source.

Long-term -  Any asset or liability that will be
used or due in more than a year into the future.

Management -  A system of organizing,
directing, and utilizing resources for maximum
efficiency.

Management Reports -  A combination of
financial data to provide the manager with
information that cannot be easily seen by looking
at financial numbers.

Managerial Capacity - The management
structure of a utility that includes ownership,
accountability, staffing, organization, and
effective links to customers and regulatory
agencies.

Narrative – Discussion, presentation, talk.

Non-profit -  An organization whose primary
objective is to service the public without the
intent of gaining wealth.

Operating Revenues -  Current inflow of
money or other assets that results from the sale
of goods or services or from the use of money or
property.

Ordinance -  A municipal or tribal law.

Outside Source -  The State of Alaska, federal
government, or other outside grantor which
provides funds to organizations usually for a
specific purpose.

Reserves -  Funds set aside for a particular use
in the future.

Revenue -  Income or money paid for services
rendered or a grant of money.

Service Disconnect -  Physically disconnecting
customer’s service due to unpaid balances.

Single Audit -  An audit of the whole
organization and all programs.

Stewardship -  An individual or entity in the
position of managing or superintending.

Technical Capacity -  Having the equipment
and supplies to do a job well.

Transaction -  The act or process of carrying
out or conducting business affairs.

Utility Fund -  The fund containing monies set
aside for the organization’s utility expenditures.
(Enterprise Fund)
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COMPUTER

Button -  An action box on your program, that
will complete the action by clicking on the box,
for example Save and Close.

Compact Disc (CD) -  Compact discs are round
discs that transport and store data. Each compact
disc is capable of holding up to 640 megabytes,
and is inserted into a CD drive to function.

Compact Disc (CD) Drives -  A disc drive used
to read a CD disk.  Drives are rated by the speed
at which they can access the information on a
disk.

CD Rom -  A CD, either readable or read-
writeable, that is inserted into the D drive of your
computer

Cursor -  The blinking bar that denotes where
your computer will receive the next command.  

Drive -  Where the computer stores and retrieves
information.  The computer has several drives
known by letter.  A common drive set up is the
3.5“ diskette drive; C drive is the internal drive
(storage) of the computer; D drive is the CD
Rom drive; E drive is the re-writeable CD drive.

Hard Drive -  The hard drive is a magnetic
storage disk located inside the computer. Hard
drives can read and write information very
quickly.  Since they save the information even if
the computer and power are turned off, they are
the preferred place to store programs and data.
They are made in a lot of different sizes, the size
is listed in Megabytes or Gigabytes.  Computers
can have more than one hard drive.

Icon -  This is a graphic, usually a small one,
that represents something, usually a file. Icons
can also represent directories, folders, or devices.

Menu -  The listing of available actions across
the top of the computer screen.

Screen -  The display of a computer, also called
a monitor.

Scroll Bar -  A bar, either vertical or horizontal
at the edge of the screen, where you can scroll up
or down, or sideways to reach unseen portions of
your document.

Tool Bar -  Usually located just below the menu
bar, the tool bar is a series of pictures or icons,
that are shortcuts to the activities.  

Window -  Whatever is appearing on your
screen at the present

INTERNET

Home Page -  The website that you web
browser will go to when you first start the
program.

Search Engine -  A program that searches for
specified topics or websites that relate to a word
or words that you enter.

Website -  A document or documents that have
been developed specifically for viewing over the
internet.

ACRONYMS

AANHS -  Alaska Area Native Health Service

ADA -  Americans with Disabilities Act

DEC -  State of Alaska, Department of
Environmental Conservation

ADES -  State of Alaska, Division of Emergency
Services

AIDEA/AEA -  Alaska Industrial Development
Export Authority / Alaska Energy Authority

ANTHC -  Alaska Native Tribal Health
Consortium

AWWA -  American Water Works Association
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RASC -  Rural Alaska Sanitation Coalition

RCA -  Regulatory Commission of Alaska

RMW -  Remote Maintenance Worker

RUBA -  Rural Utility Business Advisor

USDA-RD -  U.S. Department of Agriculture,
Rural Development

VSW -  Village Safe Water

WEF -  Water Environment Federation

AWWMA -  Alaska Water Wastewater
Management Association

AVEC -  Alaska Village Electric Cooperative

BLM -  Bureau of Land Management

CPA -  Certified Public Accountant

DCED -  State of Alaska, Department of
Community and Economic Development

DNR -  State of Alaska, Department of Natural
Resources

DOL -  State of Alaska, Department of Labor

DOT/PF -  State of Alaska, Department of
Transportation and Public Facilities

EPA -  U.S. Environmental Protection Agency

FC&O -  State of Alaska DEC, Facilities,
Construction, and Operations

FEMA -  U.S. Federal Emergency Management
Agency

IHS -  U.S. Indian Health Service

IRA -  Indian Reorganization Act

O&M -  Operation and Maintenance

OEH -  Office of Environmental Health

OIT -  Operator In Training

OMB -  U.S. Office of Management and Budget

OSHA -  U.S. Occupational Safety & Health
Administration

P&L -  Profit and Loss

PCE -  Power Cost Equalization

PM -  Preventive Maintenance

R&R -  Repairs and Replacements

DICTIONARY
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GLOSSARY OF EXCEL TEMPLATES

The Excel workbook file you receive with the
business template has the following worksheets
for use with the template.  To locate any one of
the worksheets, click on the tab at the bottom of
the page.

Statistics

Revenue

Expense

Revenue Source
Residential User Fees
Small Commercial Users
Large Commercial Users
School User Fees
User Fees from Washeteria
User Fees from Fish Processing Plant
Water Sales (per gallon)
Local Capital Contribution

Total Revenue

$105.00

$5,000.00

$5,000.00
$0.05

130

1

1
135,000

85%

100%
100%
100%
100%

$138,411
$5,000

$0
$45,000
$10,000
$20,000

$6,750
$40,000

$265,161

Monthly 
Rate

# of
Customers

Collection
Rate

Yearly
Revenues

Expense Category                  Annual Estimate
Administration
Labor
Miscellaneous Materials
Electricity
Heating Fuel
Water Treatment
Sewage Treatment
Insurance
Repair and Replacement Account
Capital Replacement Account

$23,400
$39,600
$5,940

$10,634
$20,312
$95,265
$9,527
$1,000

$17,166
$35,660

$258,504

Population
2000
1990
1980
1970
1960
1950

Housing (2003 Data)
Occupied Housing
Vacant Housing Due to Seasonal Use

Other Vacant Housing
Average Household Size

Economic Data (2000 Data)
Unemployment Rate
Median Household Income

555
501
412
340
228
194

137
7
9

4.05

15.40%
$25,156.00



Repair and Replacement

Annual Profit

Revenue                
Residential Users
Small Commercial Users
Large Commercial Users
School User Fees
User Fees from Washeteria
User Fees from Washeteria
Water Sales

Expenses
Annual Operation & Maintenance Costs
Annual Repair & Replacement Costs
Capital Replacement Account

Net Operating Income (Loss)

Net Operating Income
Local Capital Contribution
Annual Estimated Profit

$138,411
$5,000

-
$45,000
$10,000
$20,000

$6,750
$225,161

$205,678
$17,166
$35,660

$258,504
($33,343)

($33,343)
$40,000

$6,657
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Cash Flow

Description of Equipment
Washers
Dryers
Pumps
Boilers
Heat Exchangers

Total amount that should be set aside annually for major R&R costs

X
X
X
X
X
X
X
X
X
X

÷
÷
÷
÷
÷
÷
÷
÷
÷
÷

=
=
=
=
=
=
=
=
=
=

4
3
4
2
5

$1,400
$1,200
$8,000

$14,000
$1,159

$1,120.00
$720.00

$10,666.67
$3,500.00
$1,159.00

-
-
-
-
-

$17,165.67

5
5
3
8
5
1
1
1
1

Number    X          Cost      ÷ Useful Life =      Depreciation

Cash Sources                
Residential User Fees
Small Commercial Users
Large Commercial Users
School User Fees
User Fees from Washeteria
User Fees from Fish Processing Plant
Water Sales (per gallon)
Local Capital Contribution

Cash Uses
Annual Operation & Maintenance Costs
Annual Repair & Replacement Costs
Capital Replacement Account

Excess (Shortage) of Cash over Expenditures

$138,411
$5,000

-
$45,000
$10,000
$20,000

$6,750
$40,000

$265,161

$205,678
$17,166
$35,660

$258,504
$6,657
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Description               Average Rate  Times   Amount
Incomes Per Household  

Median Household Income

Expenses Per Household  
Rent
Food
Electricity
Fuel
Water and Sewer
Airfares
Clothing
Gifts/Holidays
Other

Surplus/(Deficit)

$25,156.00
$25,156.00

$5,100.00
$9,100.00
$1,800.00
$3,200.00
$1,260.00

$320.00
$2,400.00

$500.00
$1,200.00

$24,880.00

$276.00

$425
$175
$150
$800
$105
$160
$200

$100

12
52
12

4
12

2
12

12

. . . . . . .

Revenue  
Residential User Fees
Small Commercial Users
Large Commercial Users
School User Fees
User Fees from Washeteria
User Fees from Fish Processing Plant
Water Sales (per gallon)
Local Capital Contribution

Expenses/Excess of Cash over Expenses
Annual Operation and Maintenance Costs

Annual Repair and Replacement Costs
Capital Replacement Account
Excess (Shortage) of Cash over 

Expenditures

$138,411
$5,000

-
$45,000
$10,000
$20,000

$6,750
$40,000

$265,161
Expenses

$205,678
$17,166
$35,660

$6,657
$265,161
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Capital Replacement

Project Replacement Costs                               Capital Replacement Fund Balance

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30

$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000
$10,000,000

$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000
$2,000,000

$0
$35,660
$72,747

$111,317
$151,430
$193,147
$236,533
$281,655
$328,581
$377,385
$428,140
$480,926
$535,823
$592,916
$652,293
$714,045
$778,267
$845,058
$914,520
$986,761

$1,061,892
$1,140,028
$1,221,289
$1,305,801
$1,393,693
$1,485,101
$1,580,166
$1,679,032
$1,781,854
$1,888,788

$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$35,660.20
$1,069,806

$0
$1,426
$2,910
$4,453
$6,057
$7,726
$9,461

$11,266
$13,143
$15,095
$17,126
$19,237
$21,433
$23,717
$26,092
$28,562
$31,131
$33,802
$36,581
$39,470
$42,476
$45,601
$48,852
$52,232
$55,748
$59,404
$63,207
$67,161
$71,274
$75,552

$930,194

$35,660
$72,747

$111,317
$151,430
$193,147
$236,533
$281,655
$328,581
$377,385
$428,140
$480,926
$535,823
$592,916
$652,293
$714,045
$778,267
$845,058
$914,520
$986,761

$1,061,892
$1,140,028
$1,221,289
$1,305,801
$1,393,693
$1,485,101
$1,580,166
$1,679,032
$1,781,854
$1,888,788
$2,000,000
$2,000,000

Equivalent Annual Cycle Cost
Inflation rate: 0.0%                                                   Reinvestment Rate:   4.0%

Total Assets Start of Year               Annual                  Interest             End of Year

Year    Inflated Cost            Asset Cost                    Balance                  Deposit                Earnings               Balance

20% of Total

. . . . . . .



. . . . . . .

The following information is provided in accordance with State law AS 44.99.210

Name of agency releasing publication:
Department of Community and Economic Development

Production cost of the publication:
$4.63 per each printed copy

$5.00 per each CD
Free when downloaded from the website (www.dced.state.ak.us)

Purpose of the publication:
To provide residents of Alaskan communities with the tools to create a sound business plan.

City where printed:
Anchorage, Alaska

The Department of Community and Economic Development complies with Title II of the American for Disabilities Act

of 1990.  Upon request, this report will be made available in large print or other accessible formats.  Requests should

be directed to DCED staff.
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